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Editorial Focused Entirely on the Advanced Design Market

Editorial Leadership

John Blyler, Editorial Director

John is a leading authority on
the technological issues that
drive today’s chip, advanced EDA
and semiconductor industries.

He has worked in the electronics
industry for over 24 years.
Aside from editorial experience with the IEEE and
technical trade journals, he has also co-authored
books on systems-level design (IEEE-Wiley) and
RF Design (Elsevier). John remains an affiliate
professor in Systems Engineering at Portland
State University.

Jim Kobylecky, Managing Editor

Jim has worked as a technical writer and copy
editor for such high-tech firms as Mentor
Graphics, Tektronix, Credence, Merix and Intel.

Pallab Chatterjee, Regional Managing Editor
Pallab is an long-time consultant in the EDA,
Mixed Signal and custom design space.

Dave Bursky, Senior Editor,

Dave is a recognized expert in the EDA/chip design
technology. He is also the Technical Editorial
Manager at Maxim Integrated Products.

Clive “Max” Maxfield, Executive Editor,
Chip Design / iDesign

Clive is a well-known writer and speaker in the
EDA community. He is the President of TechBites
Interactive (www.techbites.com).

Erach Desai, Chief Analyst

Erach is a prominent EDA/semiconductor analyst
with many years of Wall Street experience as an
equity analyst for Credit Suisse First Boston, Alex
Brown & Sons, and SoundView Technology Group.

Geoffrey James, Business Editor

Geoffrey has written for national publications
including Wired, Business 2.0, Electronic Business,
The New York Times and others.

Cheryl Ajluni, Contributing Editor

Cheryl is a contributing editor and freelance
technical writer. She has over 12 years experience
covering the high-tech industry.

Jack Browne, Contributing Editor

Jack has over 30 years of experience. He serves as
Technical Director (contractor) of Microwaves &
RF magazine.

Nicole Freeman, Technology Editor

Nicole's editorial experiences include technology-
focused publications for AlwaysOn, IBDNetworks,
GameSpot (CNET Networks), and ZDNet.

Editorial Board

Tom Anderson, Marketing Director, Cadence
Cheryl Ajluni, Consultant, Custom Media Solns
Karen Bartleson, Stds Manager, Synopsys
Chuck Byers, Director Communications, TSMC
Rich Faris, Vice President Marketing, Real Intent
Kathryn Kranen, CEO, Jasper Design Automation
Barry Marsh, Vice President Marketing, Actel
Tom Moxon, Consultant, Moxon Design
Walter Ng, Senior Director, Chartered Semi
Scott Sandler, CEO, Novas Software

Steve Schulz, President, Si2

Adam Traidman, President, ChipEstimate

Chip Design covers all of the technical challenges and implementation options
that engineers face in the development and manufacture of today’s complex
integrated circuits (IC). Key focus areas includes the design of complex System-
on-chips (SoCs), Electronic Design Automation (EDA) tools that enable SoC design
and the semiconductor manufacturing process as it affects the design of SoCs
including FPGAs and other programmable devices.

2008 Chip Design Editorial Calendar

Materials
Issue Focus Report Key Editorial Topics Show Distribution Ad Close Deadline
Dec/Jan * Buyers’ Guide  FPGA Prototyping * Embedded World Dec. 14 Dec. 17
(2007/2008) * Power Systems *DesignCon
(Print/Online) [P Issues *DVCon
* Wireless-RF
Feb * Focus Report: Chip- * Video Programming * Multicore Expo Feb. 4 Feb.7
(Print/Online) Package_Board Co- * Multicore Design Tools * DATE
Design -Verification * Semi Interconnect Intergration «|SQED
*|P Integration
* Special Insert » Cadence/ Partners Interoperability Guide
Mar * Focus Report:Defense  * Security Issues Feb. 29 March 3
(Online) Apps * MEMs EDA Tools
« Semiconductor Adv Packaging
* Chip-Package-Board
* Special Insert * Programmable Logic Devices (PLDs)
April « Chip Design vs. EDA *Embedded SoCs * ESC Silicon Valley Mar. 28 April 2
(Print/Online) Tools * Nanotechnology Tools
 Semiconductor DFM/DFY
* Wireless Development
« Special Insert * IP Design & Verification
May « Collaboration Models-  * High Performance FPGA April 21 April 25
(Online) Design and Foundries  * System Level Design
« Semiconductor Thermal Management
* Power
* Special Insert * Analog-RF-Wireless Design
June ¢ Design-Manufacture ¢ Programmable Hardware *DAC May 19 May 22
(Print/Online) Variability « System Languages *MTTS
* Semiconductor Metrology * SEMICON
* IP Metrics
« Special Insert * Annual Product/Services Catalog
July * Chip Design Forecast P for FPGAs
(Online) * Low-Power Design
 Semi Through-Silicon Vias
* Analog-Wireless
* Special Insert * DFM/DFY
Aug * Analog Integration * PCB Design *ESC Boston August 1 August 4
(Print/Online) * Network on Chip * ARM Conference
* Semiconductor Lithography * PCB West
* Special Insert * Memory
* Mentor Partners Interoperability Guide
Sept * Hardware vs Software e Verification for Programmable Devices Sept. 5 Sept. 10
(Online) « System Level Design
* New Semiconductor Materials
* Hardware vs Software Reuse
* Special Insert « Verification and Debug
Oct * Chip Design 5 Year « High Performance FPGAs «ITC Oct.1 Oct. 3
(Print/Online) Anniversary - A look « EDA Verification Trends *ICCAD
back and forward « Semi Advanced Processes  Chip-Package-Board
. « Collaborative Platforms
* Special Insert
« Synopsys/ Partners Interoperability Guide
Nov « Career Trends * ASIC Prototyping Nov. 3 Nov. 6
(Online) « ESL Tools
» Semi Low-K-Dielectrics
* Analog-RF-Wireless
* Special Insert
» Top 20 Technologies and Gadgets
Dec * Buyer's Guide * Consumer Applications Dec. 1 Dec.5

(Print/Online) «DSP Designs
* Semi Yield Management
* Analog-RF-Wireless
* Special Insert * Buyer's Guide




Email Newsletters — Reach Targeted Audiences

with Relevant Content and News

Email Newsletter Calendar 2008

=555 H H - Chip Designer newsletter
' 7 L]
'L_fl"lﬂ' Chlp DeSIQnere NeWSIetter Issue Feature Topic Ad Close  Materials
30,000+ Subscrib
M ’ + oubscribers Jan'08 Power Jan 10 Jan8
DT e B System-on-Chip (SoC) digital and analog Feb'08 SoC Design Feb7 Feb5
ypgrer designers, system architects, IP integrators, ZAar'é]; l“:“l‘“‘:‘”ED_es'g” 2/'3’150 2/'3’;
Ppea . . . . . pr t 1
E d=wl | DFM and verification engineers will benefit i regreor pr pr
- ) 3 ) ay'08 Programmable HW May 8 May 6
il from the latest news, industry viewpoints and Juos Analog-RF-Wireless Juns Jun3
. technical articles. Covers such timely topics as Jul'08 Green Design Jul'10 Jul 8
T ESL, IP, analog mixed signal, power, DFM-DFY, Aug08 P Challenges Aug?  AwgS
p— |——— Sep'08 Lithography Sep Sep9
nanotechnology and more. 0ct'08 Advanced Chip Verification 0ct9 0ct7
e Nov'08 Design-for-Manufacturability Nov 6 Nov 4
FPGA Developer e'NeWSIetter Dec'08 Design-for-Yeild Dec4 Dec2

s |
45,000+ Subscribers FPGADeveloper
Keeps design and test engineers updated on the
latest products and technology advances in the
growing world of FPGAs, PLDs and Structured

FPGA Developer newsletter

; . Issue Feature Topic AdClose  Materials
ASICs. All aspects of hardware implementation, _ _ ,
EDA software and IP design-test issues are Jan'08 Design/Verf in Consumer Electronics ~ Jan 3 Dec 30
g Feb'08 Optimizing FPGA Design Jan 31 Jan29
covered. Mar'08 FPGA/PCB Integration Feb 28 Feb 26
Apr'08 Using FPGAs with embedded Apr3 Apr1
May'08 IP/Reuse Trends May 1 Apr29
e naaes | IP Designer - Integrator e-Newsletter Jun08  RF-Wireless Apps May2  May2s
= . Jul'08 Development Tools Jul'3 Jul'1
éi‘{ﬁ”’ m 25,000+ Subscribers Aug'08 Prototyping with FPGAs Jul 31 Jul29
—— | Intellectual Property (IP) design and integration Sep08  High-Speed /0 Issues Sept4 Sept 2
remains one of the hottest trends in the chip 0ct08  Automotive Design/Verit Oct2 Sept 30
ind t C . lud t ds i | _ Nov'08 Advanced Verification Oct 30 Oct 28
Industry. Loverage includes trends In analog Dec08  High-Speed Computing NovZs  Novzs
digital, core-memory, design, verification,
integration and qualification of IP in the SoC
space.
IP Designer-Integrator newsletter
- Issue Feature Topic Ad Close  Materials
Chip-Package-Board e-Newsletter CHIP-PACKAGE-BOARD
. DESIGNER Jan'08 IP Trends Jan 24 Jan22
25,000"‘ SUbscr’bers Feb'08 IP Interconnect Feb 21 Feb19
True system-level coverage of critical chip- Mar08 Interface IP Mar20  Mar18
package-board topic like system codesign- Apr08  IPStandards Apr2d  Apr2z
ificati P reuse Svstem-in-Package May'08 Analog Wireless May 22 May 20
CO.VeI'-I Ication, A S€, 4 A g : Jun'08 IP Metrics Jun 19 Jun 17
(SlP) ISsues, packaglng challenges (llke thermal, : . Jul'08 Memory IP Jul 24 Jul22
substrate, and pin efficiency), hardware-software | * —- - Aug08  Interface IP - Wireless Augzi  Aug19
and analog-digital trade-offs that span the whole Sep08  CorelP Sept5  Sept23
Oct'08 Verification IP Oct 23 Oct 21
system. Nov'08 Interface IP Nov 20 Nov 18
Dec’08 Low Power IP Dec 18 Dec 16
Newsletter marketing options:
B Roadblock/Exclusive—limited to one sponsor-468x60 banner at top - -
center position; side banner 125x up to 728; up to three text ads; up to five Chip-Package-Board Designer newsletter _
industry announcements. Optional bonus: additional distribution to your =218 [EATO U GHEEED LS
email lists (up to 20,000). Jan'08 FPGA-Board Jan 17 Jan 15
. Feb'08 Multicore Issues Feb 14 Feb 12
B Platinum—\Leaderboard 728x90 banner at top center position and first 100 Mar08 Stacked Die Mar 13 Mar 11
word text ad position and two trackable headline links within the newsletter. Apr'08 Interconnect Apr 17 Apr 15
. i May 08 Analog-Wirel May 15 May 13
B Gold—Top right skyscraper (120x600) banner position, second 75 word text & 00 THeTess il il
. . . A Jun'08 IP Integration Jun 12 Jun 10
ad position and one trackable headline links within the newsletter. -
Jul'08 Trends Jul 17 Jul 15
B Silver—Top 125x125 side banner position, second 75 word text ad position Aug08  Package Issues Augld  Augt2
and one trackable headline links within the newsletter. Sep'08 Bonding Issues Sep 18 Sep 16
Oct'08 Verification IP Oct 16 Oct 14
Nov'08 Interface IP Nov 13 Nov 11
Dec'08 System Trends Dec 11 Dec9




Targeted Online Advertising and Lead Generation

Chip Design Website

Stay on top of the latest technical product news, read about today’s technology
trends, find detailed technical articles, enjoy techie-style blogs and more at
www.chipdesignmag.com.

Targeted Banner Options

Maximum exposure across www.chipdesignmag.com with
banners including:

e Leaderboards (728x90) e Boombox (336x280)

eTiles (125x125) e Skyscrapers (160x600)

Targeted Design Centers

18 Chip Design centers focus on specific audiences with news,
special features, technical articles, focus reports, blogs and more.
iDesign provides engineers with weekly insights into the world of
EDA and semiconductor chip development.

> Architectual > DSP > Interface > Memory > Nanotechnology > SW Apps
> ASIC-ASSP > ESL > |P > Methods > RF-Wireless > Tester - HW
> DFM > FPGA's > Low Power > Mixed Signal > Structured ASIC > Verification

Sponsor a ChipDesign Design center and get exclusive ad placement, email broadcasts to targeted lists,
content placements and increased brand awareness

Diamond Sponsor - exclusive to one company

Platinum Sponsor - limited to two companies

Gold Sponsor - limited to eight companies
per microsite

per microsite

per microsite

> Rotating Leaderboard Banner for 12 months > Rotating Boombox banner for 12 months > Rotating 125x125 banner for 12 months
(50,000 guaranteed impressions) (40,000 guaranteed impressions) (50,000 guaranteed impressions)

> One dedicated email broadcast (to > 8 product pages or articles to post on > 5 product pages or articles to post on
minmum 20,000 qualified names) microsite microsite

> 10 product pages or articles to post on > UNLIMITED product announcements to post > UNLIMITED product announcements to post
microsite on microsite on microsite

> UNLIMITED product announcements to post
on microsite

High Quality Lead Generation

B Chip Design White Paper Program—Your white paper featured for three months on www.chipdesignmag.com and in 3
consecutive monthly email newsletters.

B Contest Sponsorship and Surveys—Sponsor a contest, create a survey of up to 10 questions and generate leads including
contact information and demographics.

Blogs/Video Blogs

Interact directly with a targeted audience of chip designers by sponsoring your own

blog!

Webcasts Webcast Schedule

Webcasts offer a forum to bring content directly to design engineers and engineering Topic Issue Ad Deadline

managers. Webcasts bring moderated informational sessions directly to attendee’s FPGA Desians April 2008 January. 18

desktops with the capability to integrate messaging with audio and power point. g -

Sponsorship includes visibility before and during the event, and a 12 month presence IP Integration June 2008 March 7

on our archives Low-Power-Design | Sept. 2008 June 14
Verification Nov 2008 August 4

Sponsor a ChipDesign
webcast or create your own



Reach Powerful Buyers with Targeted Distribution

40,000 Important Readers Chip/SoC Engineers

Chip Design is distributed in print to over 25,000 design engineers and
engineering managers working on advanced SoC designs.

Each issue is also distributed electronically to an additional 15,000
design engineers/managers.

Chip Design’s readers are chip, programmable logic device and IP-
related architects, designers, and testers. The readership also includes
software protocol-application engineers and technical program
managers. These architect-design-test engineers and managers are
responsible for creating the latest generations of ASICs, structured
ASIC, ASSPs , FPGAs, memory cores and SoC devices.

Powerful Purchasing Influence

System architect, design and test engineers and engineering managers
working on advanced SoC designs— Chip Design readers—account
for a third of all design engineers. These key enablers influence the
purchase of nearly 80% of the total EDA market—or about $4 billion.

*Source: Dataquest/Gartner

Circulation Breakdown by Job Responsibility

Over 35% of Chip
Design readers
Engineering 53.6% inﬂuence, SpeCify
B or authorize the
B Other (R&D etc.) 5.8% purchasing at
companies with
revenues of over
$500 million.

Circulation Breakdown
by Purchasing Responsibility

93.7% 79.4% 67.8.% 51.4% 55.2%

Specify/Authorize/ Specify/Authorize/ Specify/Authorize/ Specify/Authorize/ Specify/Authorize/
Influence the Influence the Influence the Influence the Influence the

purchase of Design purchase of ASICs, purchase of purchase of purchase of

Automation tools FPGAs and PLDs Intellectual Property Standard ICs Test Equipment/
and software Services DevelopmentTools

Top 20 Subscribing Companies

AMCC Broadcom Fujitsu Intel NXP Semiconductors
AMD Chartered Semiconductor Hewlett-Packard LSl Logic Qualcomm
AMI Semiconductor Cisco IDT National Semiconductor ST Microelectronics

Analog Devices Freescale Infineon NVIDIA Texas Instruments



Special 2008 Marketing Opportunities

Don’t Be Left Out of these Important 2008 Annual Resource Catalogs

Resource Catalogs include valuable application articles, industry perspectives and comprehensive details on products,
services and technologies in an easy to use data sheet format. Distributed in print, online and email newsletter
formats each Resource Catalog is designed to help over 70,000 well-qualified engineers, embedded developers and
chip designers make design trade-offs and purchasing decisions all year long.

FPGA and PLD

MIPS® 5 Technologies Solutions

Embedded Ressurce Calalag J00T I N Pebite i - Resoures Cataley FHT

PCI Express
Solutions

T FRd Gmtes

2008 Resource Catalogs

Title Pub Date Space_ Materials Deadline | Targeted Reach

Deadline
MIPS Embedded Resource Catalog March February 27 | March 3 Engineers, designers and embedded developers using the MIPS architecture
IP Solutions Resource Catalog April March 25 March 28 SoC designers, verification, engineers and system architects
Intellectual property for IC Design and Verification
Chip Design Resource Catalog June May 19 May 22 Advanced IC designers
PCI Express Solutions Resource November | Nov 7 November 14 Engineers and embedded developers using or considering PCI
Catalog Express solutions
Multicore Technologies Resource September | August25 | August?29 Developers and engineers using multicore and multiproccessing
Catalogs Architectures
FPGA and PLD Solutions Resource | December | Dec 10 December 15 FPGA and PLD applications engineers
Catalog

Chip-Package-Board Conference - Fall 2008 in Silicon Valley

System-level design and manufacturing takes center stage in this one-of-a-kind conference that combines
the technical depth, dedicated readership and broad sponsorship of both Chip Design and Embedded
Intel® solutions print and online properties — including Trends Reports, IP Integrator and FPGA Designer
publications. This timely conference will cover the embedded codesign-coverification, IP reuse, SIP, ther-
mal, substrate, pin efficiency, hardware-software and analog-digital trade-off issues spanning the design
and manufacturing of chip-package-board systems. Check the Chip Design website for information on
keynote speakers, technical sessions and exhibitors.

Put the Power of Custom Media to Work for You

Customized Email/Newsletter Program: Our teams do it all! Chip Design’s editors will help customize your con-
tent, while our web design team places your banners and announcements, all of which goes to our subscriber list to
reach your target markets. Optional Bonus: Additional distribution to email list you provide (up to 20,000) Custom
email newsletter program: $9,500 single edition rate $ 7,500/4x rate

Partner Marketing: Promote your partner network and demonstrate the depth of market support with the
Chip Design partner marketing programs

Content Services: Increase your audience and capture mindshare with compelling content.

Microsites: Combine custom content, vendor content and prepublished editorials to create a focused mi-
crosite designed to capture audiences and improve market share

Custom Magazines and Catalogs: Build a community, increase your visibility and reinforce your market
position with a custom magazine or catalog. More affordable than you think!




Chip Design Trends (CDT) Research

Chip Design Trends BiAnnual Report

Chip Design Trends (CDT) Biannual Report
Key Findings from Latest Report

Section |, Chapter 2

Aoy g ey (v ey § s e -
* Pre-Silicon design investigations grew by 18% compared to a year ago. g
e New design activity surged in Europe, followed by increases in the Asia-Pacific bt
region and relative flatness in North America. ] — =
¢ Increased use of semiconductor IP with analog-mixed signal and digital-core IP o ey
showing the largest segment growth — up by 35%! e —
® Hot markets included communications, data-processing and industrial-medical. iﬂ o _axa
* Overwhelming evidence supports the slowing of Moore’s Law! Eanh
Figure 15: The complexity quotient is tracked for gates, memory, and cores.
Figure 15 paints a very telling picture—much like what we saw for the relative divergence in highest clock
. speed in Figure 9 relative to what would be ancicipated for Moore's Law In an attempt to narrow the gap,
Basis of Report . e ool B s (ond vt sy ) e e g 4o

complexity has, at best case, been flat around 4.0 MGates for the past two years. A reasonable extrapolation
of Moore's Law should be yielding an average north of 7.0 MGates in the first quarter of 2007.

e Over 44,000 unique, worldwide and regional pre-silicon design investigations
* Analysis and forecasting of key chip design metrics, including power, die size, A bondr o i 16 demarttcts st s of-mre 80 b 6" b iz e

clock speed, analog vs. digital I, metal layers, technology nodes, memory us Pbang e bl o ot et g oo o o o ot o et T
age and much more.

nearly 80% back in the fiest quarter of 2005. Recently, though, it seems to be seteling around 70%.

B e L]

Available Now! = -
Report ID: TB10235 \ ’
Price: $1,950 (One Issue); $2,950 (Two Issue)

Forecast the Future with Chip Design Trends e
( C DT) C u Sto m Resea rch Re p o rts All print and electronic rights are the property of Chip Design © 2007 17
CDT Advantage:

¢ A growing aggregated database of over 44,000 unique pre-silicon, chip architectural design investigations — precursors to
chip starts — containing important complex SoC metrics such as power, die area, clock speed, IP, processor-memory-interface
cores, technology nodes, metal layer, regional user-market breakdowns and more.

* Access to the Chip Design property (print/online/e-Newsletters) readership, which represents leading Integrated device man
ufacturers (IDMs) — traditional chip design and manufacture vendor, fabless IP companies, EDA tool suppliers, semiconduc
tor equipment vendors and foundries.

¢ As appropriate, access to the Chip Design affiliate sponsor subscribers, including leading chip, EDA and semiconductor
organizations

¢ Chip Design’s cadre of leading technology and business editors/analyst

Methodology:

¢ Email/Web-based surveys and polls of Chip Design'’s over 45K targeted subscribers + affiliate sponsors.

¢ Data mining of and cross-referencing within our growing aggregated database of over 44,000 unique chip design metrics.
¢ Interview — phone and in person — with our subscribers and leading executives.

¢ Client involvement in tailoring and weighting of survey questions and data mining parameters

¢ Blind surveys, send to third party agents, are available

Future ReportTopics:

¢ ASIC Prototyping with FPGAs —Technology trends and regional/market segmentation

e Multicore challenges for memory, processors and buses designs

¢ Intellectual Property (IP) Usage — random-logic, embedded memory and non-memory, and I/Os
* Analog Mixed Signal (AMS) and RF-Wireless silicon trends

* Chip-Package-Board design and manufacturing trends and market profile

e Embedded SoC memory forecasts

¢ Design-for-Manufacturability (DFM) tools survey

Pricing:

¢ Multi Client: $9,500 H De H
¢ Single Sponsor: $15,000 ol:mmmm : n

To Learn more contact: Melissa Sterling at 415.970.1910 or msterling @ extensionmedia.com



Participate on a regular basis with premium display advertising, data
sheets, inserts, advertorials, conference exhibits and sponsorships

Save 25% on Print and Online Issues —place your order before December 31, 2007

TXRATE  3XRATE 6XRATE | Solution Provider Advertorials / White papers

Full Page $4,500 $4,125 $3,750 | Showcase your company as an important solutions provider with articles, case
500 5800 $5000 | ke s e ppasostor i e sl Stnovcer secton of
1/2 Page (horiz. or vertical) $3,050 $2,775 $2,500 ' ' '
1/3 Page (vertical only) $2,150 $1,900 $1,700 1X RATE 3X RATE 6 X RATE
1/4 Page $1.625 $1,440 $1.275 | 1 page Article $2,500 $2,000 $1,500
Add this percentage for Premium Positions 2-Page Article (spread w/Ad okay) $4,500 $3,500 $2,500
Back Cover - 20% Product Showcase 1 X RATE 3 X RATE 6 X RATE
Inside Front Cover - 15% Full Page Data Sheet $3,000 $2,250 $1.500
Inside Front Cover Spread - 15% 1/2 Page $2,000 $1,500 $750
Opposite Inside Front Cover (1st right page) - 10% 1/4 Page $950 $855 $750
Inside Back Cover - 5%
OppositeToC - 5% Recruitment Advertising 1XRATE  3XRATE 6 X RATE
Opposite Editorial Page - 5% 1/2 Page Classified Ad $895 $670 $500
Center Fold 2-Page Spread - 5% 1/4 Page Classified Ad $495 $370 $300

1/8 Page Classified Ad $275 $250 $200

Chip Design Magazine - Online Only Issues - Saves 25% Place an order before December 31, 2007

Diamond Sponsor (1 Company Only) Platinum Sponsor (3 Companies Only) Gold Sponsor (5 Companies Only)

> Leaderboard Banner on issue’s home page > Rotating Skyscaper Banner on that issue’s home page | > Rotating Boombox Banner on that issue’s home page
> Leaderboard Banner on email announcing release of issue (over

40,000)

> 125x125 banner on email announcing release of
issue (over 40,000)

> 125x125 banner on email announcing release of issue (over 40,000)

> Promote with headline links up to 5 white papers or data sheets > Promote with headline links up to 3 white papers | > Promote with headline links up to 1 white papers or data sheets

on issue’s homepage and email announcement or data sheets
> Logo on cover identified as Diamond Sponsor
> Back cover display ad

> $7,500 per issue or $5,000 6x rate

> Logo on cover identified as Platinum Sponsor
> Premium position display ad

> $5,000 per issue or $4,000 6x rate

> Logo on cover identified as Gold Sponsor

> One display ad in online issue

> $2,500 per issue or $2,000 6x rate

Resource Catalogs (save 35% - place your order before December 31st)

DATA SHEETS Standard Rate Add Color DISPLAY ADS/ADVERTORIALS Standard Rate Add Color
1st Full Page Data Sheet $1,495 $250 2 Page Spread, Black and White $3,750 $400
Each Additional Full Page Data Sheet $1,175 $250 1- Page, Black and White $2,750 $300
Matrix Page $2,000 $250 1/2 Page (Horiz.), Black and White $2,000 $250
1/2 Page Data Sheet $995 $150 1/4 Page, Black and White $975 $150

DIAMOND SPONSORSHIP (exclusive to one company per catalog)

$17,000

> Logo on catalog cover (top right corner) on the online catalog microsite homepage
> 10 pages (4-color) in print catalog to use as Display Ads, Data Sheets or Advertorials

> Guaranteed Display Ad Position Back Cover

> Rotating 728x90 Leaderboard banner on catalog microsite home page for 12 months(50,000 guaranteed impressions)

> (1) dedicated email broadcast (minimum 15,000 qualified names)
PLATINUM CO-SPONSORSHIP (limited to two companies per catalog)

> Logo on catalog cover and online catalog microsite homepage

$12,500

> 8 pages (4-color) in print catalog to use as Display Ads, Data Sheets or Advertorials

> Guaranteed Display Ad Position (Inside Front Cover or Page 1)

> Rotating 125x125 Ad banner on catalog microsite home page for 12 months (40,000 guaranteed impressions)

GOLD CO-SPONSORSHIP (limited to 8 companies per catalog)

> Logo on catalog cover and online catalog microsite homepage

$10,000

> 5 pages (4-color) in print catalog to use as Display Ads, Data Sheets or Advertorials
> Guaranteed Display Ad Position (Opposite TOC 1 & 2, Opposite Intro, Opposite Advertorials)
> Rotating 125x125 Ad banner on catalog microsite home page for 12 months (50,000 guaranteed impressions)

DELUXE PRINT/ONLINE PACKAGE

> 4 pages (4-color) to use as Display Ads, Data Sheets or Advertorials

> 125x125 rotating Ad Banner on catalog microsite
home page for 3 months

$6,250

Chip - Package - Board Conference - Fall 2008 in Silicon Valley

Attend the Conference!
d $349 - Full 2 day Conference Package
1 $199 - One day conference Package

Sponsor and Table - Top Exhibitors Rates

1 Diamond Sponsor - 1 company only $10,000
1 Platinum sponsors - 3 companies only $7,500
1 Gold sponsors - 5 companies only $5,000

1 TableTop Exhibit - $2,500



Participate with Online and Interactive Advertising, Email Newslette
Advertising, Lead Generation Programs and Sponsorships

Internet Advertising

Banners on www.chipdesignmag.com Design Centers and iDesign Sponsorships

Save 35% - Place your order before
Pixel Size Rate(CPM) December 31st

Boom Box 336x280 $200
Skyscraper 120x600 $175
Leaderboard 728X90 $175

Diamond Sponsor - exclusive to one company per microsite
$17,500/12 months

> Rotating Boombox Banner for 12 months
Tile Banners 125x125 $75 (50,000 guaranteed impressions)
> One dedicated email broadcast
(to minimum 20,000 qualified names)
> 10 product pages or articles to post on microsite

Lead Generation Programs

Rate > UNLIMITED product announcements to post on microsite
> Chip Design White Paper Program $1000
per month Platinum Sponsor - limited to two companies per microsite
> Custom Microsites - $2,000 $12,500/12 months
ini th

(3 month minimum) . permon > Rotating Boombox banner for 12 months
> Contest/Survey Sponsorships - $2,000 (40,000 guaranteed impressions)

(3 month minimum) per month

> 8 product pages or articles to post on microsite
> UNLIMITED product announcements to post on microsite

Sponsored Blog Participation

» $1000 per month (3 month minimum)

Gold Sponsor - limited to eight companies per microsite
$10,000/12 months

Webcast sponsorships > Rotating 125x125 banner for 12 months

(50,000 guaranteed impressions)
» Vendor sponsored $9,500 > b product pages or articles to post on microsite
> UNLIMITED product announcements to post on microsite

ChipDesign Webcasts

» Diamond Sponsor (one only) $7,500
P Platinum Sponsor (three only) $4,950

Email Newsletter Sponsorships

EMAIL ONLY
Roadblock/exclusive Limited to one sponsor $7,500/issue
468x60 banner at top center position; side banner 125 x up to 728; up to three text ads; up to five industry announcements.
Optional bonus: additional distribution to your email lists (up to 20,000)
Platinum Sponsor $3,000/issue
728x90 Leaderboard banner at top center position and first text ad
Gold Sponsor $2,500/issue
Skyscraper top right banner position and second text ad
Silver Sponsor $2,000/issue
First 125x125 banner position third text ad
Bronze Sponsor $1,500/issue
Second 125x125 banner position fourth text ad
Exte ns i on About Extension Media CONTACTS
Extension Media is a publisher of busi-
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